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Trademarks
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RadWhere™ are trademarks or registered trademarks of Nuance Communications, Inc. or its affiliates in the United
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respective owners.

Copyright Notice

This manual is copyrighted and all rights are reserved by Nuance Communications, Inc. No part of this publication
may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer
language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise,
without the prior written permission of Dictaphone Healthcare Solutions, Nuance Communications, Inc., 1
Wayside Rd., Burlington, MA 01803.

Copyright © 2017 Nuance Communications, Inc. All rights reserved.

Disclaimer

This document is provided "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR
NON-INFRINGEMENT. Nuance shall not under any circumstances be liable to any person for any special, incidental, indirect or
consequential damages, including, without limitation, damages resulting from use of OR RELIANCE ON the INFORMATION presented,
loss of profits or revenues or costs of replacement goods, even if informed in advance of the possibility of such damages.

Every effort has been made to ensure the accuracy of the information presented. However, Nuance assumes no responsibility for the accuracy
of the information. Product information is subject to change without notice. Changes, if any, will be incorporated in new editions of this
publication. Nuance may make improvements and/or changes in the products and/or the programs described in this publication at any time
without notice. Mention of non-Nuance products or services is for information purposes only and constitutes neither an endorsement nor a
recommendation.
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Pre-Upgrade Checklist

Step Task Information

Pre Install

Review Upgrade Questionnaire Review for possible conflicts.

Confirm Remote access Review and Update CRM as appropriate.

Confirm User IDs and Passwords Review and Update CRM as appropriate.

Verify OS Configuration Windows Server 2012 Installation and Configuration Manual — 
889676

Windows Server 2008 R2 Installation and Configuration Manual 
— 889675

Verify and upgrade, if necessary, MS 
SQL to the latest supported version

Microsoft SQL 2016 Installation and Configuration Manual — 
889784

Microsoft SQL 2014 Installation and Configuration Manual — 
889678

Microsoft SQL 2012 Installation and Configuration Manual — 
889677

Confirm if using PS360 Faxing See If site will FAX out of PS360 Downgrade PDF version on 
Application Server

Is there a hot spare? See Upgrading Systems with Mirrored Hot Spare Configuration 
(Hot Spares on version 3.0.x and lower)

or

See Upgrading a System Which Uses “AlwaysOn SQL”

Is LDAP enabled? If LDAP is enabled, disable LDAP before upgrading. 
After the upgrade is complete, enable LDAP.

Install

Upgrade from V1.x Use Software Installation Manual — 889718 

Post Install

Is there a Hot Spare? Hot Spare Installation and Configuration — 889715

Client Hot Spare — 889719

Perform Checkout System health checks tool is on the DML:
https://private.filesany-
where.com/Nuance/fs/v.aspx?v=8972658a9e61b47a9e

Is LDAP disabled? If LDAP is disabled, enable LDAP after the upgrade is complete.

https://isupportcontent.nuance.com/healthcare/documents/manuals/889676/889676.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889675/889675.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889784/889784.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889678/889678.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889677/889677.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889718/889718.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889715/889715.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889719/889719.pdf
https://private.filesanywhere.com/Nuance/fs/v.aspx?v=8972658a9e61b47a9e


PN 889679 March 31, 2017 1-2

Preliminary Steps

If you experience an issue using the tool, revert to the manual
uninstall / reinstall process outlined in the standard install manual for
your version.

Backup the System Data

System Snapshot

 Have the Client take a system snapshot (VM or otherwise) of the Application and
SQL server before starting this process.

Backup the Nuance Data Folder

 Make a backup copy of the x:\Nuance\ directory and sub folders.

 Place the backup(s) in a safe location, preferably in a place other than the server
itself.

Upgrading Systems with Mirrored Hot Spare Configuration
(Hot Spares on version 3.0.x and lower)

If the site has the Mirrored Hot Spare configuration in use (e.g. SQL mirroring),
perform the following:

1. Break the mirror between the production and Hot Spare systems and turn off
mirroring.

2. Disable and delete the Hot Spare Windows scheduler jobs used to replicate
profiles, waves, and logs on both the production and hot spare systems

3. If not already performed, you will need to upgrade the operating system of the
MSSQL server to the Windows Enterprise version by applying the new/proper
license keys.

4. If not already performed, you will need to upgrade the MSSQL server application
to the Enterprise version by applying the new/proper license keys.
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Upgrading a System Which Uses “AlwaysOn SQL”

The following provides the steps for upgrading the PowerScribe 360’s Comm4
database on a system running SQL AlwaysOn High Availability:

1. Stop all Nuance Application Services.

2. Make sure that the site's Primary server is set as the Primary Database server. If
not, fail it over to the Primary server.

Remove Secondary Replica

1. Log in to the SQL Enterprise Manager to the Primary server.

2. Expand AlwaysOn High Availability.

3. Expand Availability Replicas.

4. Right-click the Secondary Replica, and select Remove from Availability Group.

The Remove Secondary Replica from Availability Group dialog displays.
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5. On the Remove Secondary Replica from Availability Group dialog, click OK to
remove the Secondary Replica. 

Remove Comm4 Database from Availability Databases

Next follow these steps to remove the Comm4 Database from the Availability
Databases before you upgrade it.

1. Expand AlwaysOn High Availability.

2. Expand Availability Databases.
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3. Right-click Comm4 database, and select Remove Database from Availability
Group.
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The Remove Database from Availability Group dialog displays.

4. On the Remove Database from Availability Group dialog, click OK to remove the
database.

5. Run DBSetup as you normally would pointing at the Primary SQL server. 
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Verify Access to IPs and Ports

Allow Internet access to the following IPs and ports. Verify the server has access to
at least 2 of these URLs during the Application install. Access to them can be removed
after the install is complete. These URLs are only used when running the Client
Administration Configuration Tool later in this process.

http://timestamp.globalsign.com/scripts/timestamp.dll

202.176.218.10:80

202.176.218.11:80

202.176.218.12:80

http://timestamp.comodoca.com/authenticode

91.199.212.132:80

http://tsa.starfieldtech.com

173.201.19.11:80

68.178.177.11:80

http://sha256timestamp.ws.symantec.com/sha256/timestamp

If the site does not allow access to the Internet from the application server you will need
to download the PS360ClientCabFileSigner tool to allow proper generation of the
publication off line (without Internet) so a proper timestamp is applied.

Apply All Firmware and Microsoft Updates

Before beginning, run the Microsoft Updates tool and ensure all current Critical and
Important updates are applied to the system. This is to help ensure that IE is at version
11 and that .Net Framework 4.5 is also installed.

Also, if the server was sold by Nuance and is under a maintenance contract, update the
HP firmware and applications.

http://sha256timestamp.ws.symantec.com/sha256/timestamp
http://timestamp.globalsign.com/scripts/timestamp.dll
http://timestamp.comodoca.com/authenticode
http://tsa.starfieldtech.com
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Cleanup Windows Accounts

Window accounts that were previously used in PowerScribe 360, PowerScribe or
RadWhere may no longer be used.

Delete all existing Windows accounts previously used by the application, except for the
accounts which were created as specified in P36A064 — PowerScribe® 360 Reporting
Accounts and Passwords for PS360 Installation.

Run the SQL Account Manager Tool

Prior to upgrading the Comm4 database from a previous version, you must make sure
the SQL accounts are using the proper passwords.

1. Verify if the SQL account PS360User exists.

2. If it does not, create the account using the SQL User Management Tool.

https://isupportcontent.nuance.com/healthcare/documents/ats/resource/p36/P36a064.pdf
https://isupportcontent.nuance.com/healthcare/documents/ats/resource/p36/P36a064.pdf
https://isupportcontent.nuance.com/healthcare/documents/ats/resource/p36/P36a064.pdf
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Upgrade Process

If the version of PowerScribe does not have the Client Admin icon, manually delete the
folders. If the Client has a separate Services server, you will need.

Software Download

1. Create a folder X:\Software\360_Install\<Version to Upgrade>. 

2. Download the PowerScribe 360 Version software you are upgrading to and place
it in the X:\Software\360_Install\<Version to Upgrade> folder.

3. Right-click each step from the PowerScribe_360_Install Folder and choose
Extract All to extract each step to the X:\Software\360_Install\<Version to
Upgrade> folder. 

Client Admin Cleanup

1. Double-click the Cleanup ClientAdmin icon on the desktop.

The PS360 Reporting Client Cleanup Tool dialog displays.

2. Check the boxes and click Delete Folders. The application closes.

3. If the version of PowerScribe 360 Reporting you are upgrading does not have the
Client Admin Cleanup Tool on the desktop, you need to manually delete the
folders indicated above.

4. If the Client has a separate Mobile Server or separate Reporting Services server,
you will need to repeat this process on those servers.
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Run Upgrade Tool

Be sure you are using the latest Upgrade Tool.  
Use the Upgrade Tool version 2.0.4.0 for PowerScribe 360 Reporting
versions up to 3.5.x, and version 4.0.0.5 for PowerScribe 360 Reporting
4.x versions.

1. Right-click the Upgrade Tool exe, and choose Run as Administrator.

The Report Update Tool Welcome dialog displays.

2. Click Next. The Installed components and versions display on the Current
Configuration dialog.

3. Click Next.

The dialog boxes for each installed component are displayed along with the
configuration information. Do not make changes, this is only for review.

4. The Application Service Dialog displays; click Next.

5. The Portal Configuration Dialog displays; click Next.

6. The Radiology Bridge Configuration dialog displays; click Next.

7. The Mobile Bridge Configuration dialog displays; click Next.

8. The File Uploader Configuration dialog displays; click Next.

9. Reporting Service Configuration dialog box displays; click Next.

The Check Reporting Service connection message displays.

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#UpgradeTool
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10. Client Administration Configuration dialog box displays; click Next.

11. Once, all the Configuration dialog boxes for each component are done, the utility
displays a dialog providing a Summary of the configuration information of all the
present components.

12. Click SAVE. This must be done to create the config file for the upgrade.

13. Save file to location where you can easily access it.
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The Saving Installation summary file dialog displays.

14. Click OK. This saves the configuration information to the default desired location
in two formats.

Matt
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The Pre-Uninstallation Summary dialog now displays the SAVE button disabled,
and the Start button enabled.

15. Click Start. 

The Setup Status dialog displays the uninstall process.
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Once, all the components are uninstalled, a popup questions you if you want to
continue the installation

.

16. Make sure you click No.

The InstallShield Wizard Complete dialog displays.

17. Click Finish to reboot server.

A reboot is required at this point in the process.

IMPORTANT
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Run Database Upgrade

For a cluster configuration, update the database only once on the
Virtual SQL Server Instance. 

1. In the X:\Software\360_Install\<Version>\Step_01_DBSetup_X.x.xx.x folder, 
double-click DBsetup.exe.

2. Click Run.

The Configuration File dialog displays.
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3. The SQL Server Login dialog displays; click Next.

4. Enter the Server Name.

If the server is a cluster, use the SQLClusterName.

5. Enter the SQL User Name sa.

6. Enter the Password.

7. Click Next.

8. Take note of the Comm4 database version.

9. Click Next.
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The Configuration Setup dialog displays.

10. From Select Type, select the proper upgrade selection. Do not select New
PS360Database US English.

11. Click Next.

For V3.5 and above, the File Stream Setup dialog displays.

12. Change the File Stream Location drive to X:\Nunace\FileStream. 
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In order to activate the boxes below, you need to update the location
directory.

13. Click Apply, and then click Next.

The Setup Script dialog displays and the wizard builds the list of statements used
to populate the database.

14. Click Next.
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The Script Run dialog displays.

15. Click Run.

Wait for the installation to finish. 

16. Click OK on the Success dialog.

17. Click Exit. The new upgrade of the database is complete.

a. Right-click the Database Properties and select Options.

b. From the Recovery model list, select Full.

18. Click OK.

Update Database Statistics
(V 3.5.1 and below ONLY)

1. Download the PS360 Update All Statistics.txt file from Confluence.

2. Save the file with the sql extension.

3. Open the script in SQL Management Tool.

4. Run the script against the COMM4 Database.

Set DB Recovery Level

Next, use the following steps to prep the database to be added back to the Availability
Group.

When the database upgrade is finished, the Comm4 Database will need to be changed
from Simple Recovery Model to Full.

1. Right-click the Comm4 Database, and select Properties. 

https://wiki.nuancehce.com/download/attachments/268425227/PS360%20Update%20All%20Statistics.txt?api=v2
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The Database Properties dialog displays.

2. Select Options.

3. From the Recovery Model list, select Full.

4. Click OK.
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Backup the Comm4 Database

1. Right-click the Comm4 database.

2. Select Tasks.

3. Select Back Up.

If needed, change the backup location. Any location is fine, just be sure
to set the Backed Up flag to True.

4. Click OK.

5. When the backup job is finished, click OK.

Add Comm4 Database Back into Availability Group
(For systems with Hot Spare at v3.5.1 and above)

1. Expand AlwaysOn High Availability.

2. Expand Availability Databases.
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3. Right-click Availability Databases and select Add Database. 

 



PN 889679 March 31, 2017 1-23

The Add Database to Availability Group Introduction dialog displays.

4. On the Add Database to Availability Group dialog, click Next. 
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The Add Database to Availability Group Select Databases dialog displays.

5. Check the Comm4 database.

If Comm4 is grayed out, re-run prerequisites steps for Full Backup or
Full recovery mode.

6. Click Next.
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Completing the Upgrade - Installing Your New Version

1. Right-click the Reporting Upgrade Tool exe, and select Run As Administrator.

2. Click Next. 

A popup question dialog displays.
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3. Click Yes. The Installer Location dialog displays.

4. Click Browse and navigate to the location of the extracted Step 2 folder for the
new PowerScribe 360 version.
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5. Click OK. The Reporting Update Tool utility will validate the path to check if the
new Installer. The Next button will not be enabled until a path is provided.

6. Click Next.
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The Configuration Summary File Location dialog displays.

7. Click Browse and navigate to the location of the 
PS30_ConfigurationInformation.xml file you saved earlier. The Next button will 
not be enabled until a path to PS360_ConfigurationInformation.xml is provided.



PN 889679 March 31, 2017 1-29

8. Click Next. 

The Configuration Summary File Location dialog lists the components included
in the new version along with those which were previously not installed on that
server.
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Optional Screen: If there are components that were not previously installed the
Component Selection dialog displays.

9. Check any component that was not previously installed, if you want them to install
now, and then click Next.

10. Selected components will be installed with their default values. Dialogs for each
installed component are displayed along with configuration information which is
extracted from the Configuration Information File. These settings should not be
changed to keep the configuration exactly like the previous version. Click Next
for each displayed dialog.
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Below are two sample screen shots you see of dialogs that will display.
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11. When the Portal Configuration dialog displays, be sure to check the Enable 
caching box if it is not checked.

The Web Service Log Folder field option is available on the Portal
Configuration dialog during upgrades to V4 and higher.

12. OPTIONAL STEP: If the Web Service Log Folder on a system upgrade to V4
and higher is not C:\Nuance\Logs, change the folder path to point to the
Nuance\Logs directory.
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13. When the Mobile Bridge Configuration dialog displays, be sure to check the
Enable caching box if it is not checked.

The Web Service Log Folder field option is available on the Mobile
Bridge Configuration dialog during upgrades to V4 and higher.

14. If the Web Service Log Folder on a system upgrade to V4 and higher is not
C:\Nuance\Logs, change the folder path to point to the Nuance\Logs directory.
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15. Once all of the install dialogs have been completed, the Pre-Installation dialog
displays. Click Install.

16. Once all the components are installed, the InstallShield Wizard Completed dialog
displays. Click Finish.
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Client Administration Configuration Tool

For a Cluster Configuration, use the Application Cluster Virtual Name for the URL and
the SQL Virtual Cluster Name for SQL connections.

If you are upgrading a DOD or a site where the server does not have access to the
Internet, download and use the latest version of the PS360 Client Cab File Signer. The
tool can be downloaded from the DML under PowerScribe 360 Reporting\Support
Utilities\Client Cab File Signer. 

The PS 360 Client Cab File Signer utility provides the means to create a PS 360 signed
ClientSetup.cab file outside of using the Client Administration application on the PS
360 application server. Using this utility in conjunction with the updated Client
Administration application to allow building the ClientSetup.cab file without signing,
customers like the Department of Defense that do not allow access to the signing
timestamp server can deploy from the Application server URL.

To disable Cab signing in the ClientAdmin Utility, edit the ClientAdmin.exe.config and
set TurnOffCabSigning to True. The feature is supported in PS 360: 
v3.5.1, 
v3.0.1 (PS360v301ClientAdminUpdate-4-7-2016.zip), 
v2.5.3 (PS360v253ClientAdminUpdate-4-7-2016.zip) and 
v2.0.3 (PS360v203ClientUpdate-50713-5-31-2016.zip)

Once the ClientSetup.cab is created with the utility, use it to replace the one located in
the <drive>:\inetpub\wwwroot\PS360ReportingClient\Client folder.

The tool will sign the ClientSetup.cab using sha256. This should allow the site to install
MS KB 3123479.

PS 360 v3.5.1 has been updated to support sha256. This tool is not
required for PS 360 v3.0.2, v3.5.1 and greater. 

To use this tool, you must first download and install the proper hot fix version of the
Client Cab File Signer Utility.

 v3.5.x

 v3.0.1

 v2.5.3

 v2.0.3

IMPORTANT

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#ClientCabFileSigner
https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#ClientCabFileSigner
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Run Client Admin Utility

1. Click the new Client Administration icon on the desktop.

The Client Administration Tool dialog displays.

2. Check the Create Web Installer option with Default Web Site and 
PS360ReportingClient for the Web Site/Folder options.

Do not select the shared folder installer.

a. If you are installing to a cluster, set the URL to the virtual cluster name.
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3. Check the Create DVD Installer box.

a. Set the DVD Destination Path: X:\Nuance\DVD Install

4. Set the Dragon Source Path.

You should be installing the latest version of the Dragon software
for your new version. 

a. To find this source path, use the ellipses button for this entry and browse to
the location where you extracted the Dragon disk/image files.

The application will detect Dragon Installers available and check them
appropriately.

5. Enter the Integration Components Source Path and the Publication Source
Path.

a. To find these source paths, use the ellipses buttons for each entry and browse
to the location where you extracted the Step_03_PowerScribe360_X.x.xx.x
files. These will be in the path under that step.

6. Click OK.

IMPORTANT

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#DNS
https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#DNS
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The Client Administration Tool dialog displays.

If this is a DOD facility, you should enable and add a site security
message by checking the box.

7. Verify the RAS server site URL setting. If installing to a cluster, you must change
the server name to the virtual cluster name.

8. Click Generate.
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The Publication dialog displays.

9. Click Edit User Configuration.
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Confirm that the actual server name is entered in place of localhost.

10. Click on the Integration Options tab.

11. Enter or verify that the port is 9090 and click OK.

The Publication dialog displays.

12. Click OK to generate the publication. Wait while the publication is generated. You
are returned to the Client Administration Tool dialog.

After the generation of the publication, you will note that the Publication Version
now appears.

The PowerScribe 360 Reporting Client successful install dialog displays.

13. Click OK.

14. Click Close.



PN 889679 March 31, 2017 1-41

If site will FAX out of PS360
Downgrade PDF version on Application Server

If the site is using PS360 for faxing (direct from PS360), you will need to uninstall the
version of PDF that was installed with the application server (8.1) and down grade /
install Nuance PDF v7.1.

This issue impacts v3.x and v4.x and is not required for other versions.

PowerShare Accelerator

1. Verify the version of PowerShare Accelerator that is installed on the application
server.

2. If the version is NOT 2.3.4, download the latest version (2.3.4) from the Definitive
Media Library and upgrade the current installation.

3. Run the new installer to upgrade.

4. When asked, click YES to “Preserve config”.
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Apply Post Installation Hot Fixes

Download and apply all available hot fixes for the version you have upgraded. Hot
fixes to apply for each version are listed below.

Review the Patches and Hot Fixes Table for the latest” updates, so the
installer can be sure what additional HFs have to be applied on top of
patches. For example, 3.0.1 Patch 2 contained a RadBridge and
RadPortal update, however newer RadBridge and RadPortal hot fixes
override what was in the patch.

Enable UAC

In order for Remote Diagnostics to properly operate, it requires that the User Account
Control (UAC) settings be enabled on the servers. This should be set to the second
(2nd) lowest setting.

1. From Start select Control Panel.

2. On the Control Panel, click User Accounts.

3. On the User Accounts window, click User Accounts.

4. On the User Accounts tasks window, click Turn User Account Control on or
off.

5. Adjust UAC to the level shown below:

6. Click OK.

7. Click Restart Now to apply the change right away, or click Restart Later, and
then close the User Accounts tasks window.

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#PatchHotFixes
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Mobile Server

If the mobile Server application was not installed on the main Application Server,
perform the upgrade process on the Mobile server platform.

1. Verify the Remote Diagnostics configuration.

Enable UAC

In order for Remote Diagnostics to properly operate, it requires that the User Account
Control (UAC) settings be enabled on the servers. This should be set to the second
(2nd) lowest setting.

1. From Start select Control Panel.

2. On the Control Panel, click User Accounts.

3. On the User Accounts window, click User Accounts.

4. On the User Accounts tasks window, click Turn User Account Control on or
off.

5. Adjust UAC to the level shown below:

6. Click OK.

7. Click Restart Now to apply the change right away, or click Restart Later, and
then close the User Accounts tasks window.
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Speech Server (SUS)

Verify Dragon Version

If you are performing an upgrade from a previous version of PowerScribe 360
Reporting:

1. Verify that the SUS server has the latest version of Dragon Software installed. 

2. To verify the Dragon version, perform the following on the SUS server:

a. From start, click Dragon SDK Client edition 12.5. 

b. Click show Dragon Log. This will open the C:\Users\<Windows
User>\AppData\Roaming\Nuance\Dragon SDK Client Edition12 directory.

c. Double-click dragon.log.

The Version is provided at the top of the dragon.log.

For example: 08:20:03.105 Dragon NS ActiveX Components: File 
C:\Program Files (x86)\Nuance\Dragon SDK Client 
Edition12\Program\dnstk10.dll: Version 12.52.150.151

d. If the Version is lower than the latest version, you must upgrade the Dragon 
client on the SUS server and SUS nodes before upgrading the SUS 
application.

Upgrade Dragon SDK Medical Software on SUS

1. Copy the Dragon12DOT5PS360SP##.exe file to the SUS machine. 

2. Double-click the file.

3. Click Update.

4. Click Finish.

5. Reboot the server (if prompted).

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#DNS
https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#DNS
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Verify SUS Version

1. Verify the SUS version is the latest version. 

a. If the versions are up to date for Dragon and SUS, set the Services to run
under the services account. Use the same services account you used for the
services on the application SQL server.

 DistributedManagementFramework: Agency

 SQL Server

 SQL Server Agent

 SPARK host manager service

 SPARK speech node manager

 SPEECH utility server

 SPARK core services

b. If the Dragon is up-to-date, but SUS is not, skip to Uninstall Applications
section below.

c. If the neither versions are up to date for Dragon or SUS, continue to the next
step.

Uninstall Applications

Uninstall SUS (if not correct version):

1. Stop the following services:

 SPARK host manager service

 SPARK speech node manager

 SPEECH utility server

 SPARK core services

2. Open Windows Task Manager and click the Processes tab.

3. Sort the processes alphabetically by Image Name.

4. Highlight the Nuance.ConversionServer.ClientApp.exe process, click End
Process, and confirm the action.

5. From the Control Panel/Programs and Features, uninstall the Speech Utility
Server software.

6. Open Microsoft SQL Server Management Studio.

7. Right-click the SPARK database and delete it.

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#SUS
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Uninstall SQL Express (if not correct version) 

Go to Control Panel/Programs and Features and uninstall the MS SQL Express
software.

Verify the Folders are Properly Configured

On SUS, verify that the folder named Nuance (and it's sub folders) have Full Control
for both the folder permissions and the share permissions assigned to the service
account you created.

Ensure the Everyone account is not assigned to folder or share permissions.
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Upgrade Microsoft SQL Server Express

You should always upgrade to the latest Microsoft SQL Express software
version supported by your version.

1. Download and extract the zip folder.

2. Double-click the installation file. The SQL Server Installation Center dialog
displays.

3. Select Upgrade from SQL Server 2005, SQL Server 20008, or SQL Server
2008 R2.

IMPORTANT
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The License Terms dialog displays. 

The wizard lists information about product updates available to install.

4. Check I accept the license terms, and click Next.
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The Product Updates dialog displays.

5. Check Include SQL Server product updates, and click Next.
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The Select Instance dialog displays.

6. Click Next.
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The Complete dialog displays.

7. Click Close.
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Install the SUS Software

Step 2 - Welcome Window

Navigate to the setup.exe and double-click it to start the installation.
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Step 3 - Feature Selection Window

1. Click Next on the Welcome dialog to display the Custom Setup dialog.

2. If this is the main SUS Server or a Profile Storage SUS server, check both of the
following:

 Install SUS Server

 Install SUS Speech Node

OR

 If this an additional SUS Server, check only the Install SUS Speech Node
option.

3. Click Next.
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Step 4 - Server Settings Window

After completing the steps above with the proper selections, click Next to continue to
reach the dialog below to display the Speech Utility Server Setup dialog. You must
enter the destination directories for the logs. The following is an example:

1. Enter/verify the location for the paths to the Dragon log files and SUS log files
for this server, using the correct drive letters and folder names.

If this is going to be a Profile Server, check This server is used as the
Profile Storage file server.

2. Set the database server name or connection string to:

.\SQLEXPRESS

3. Set the Folder path for the SQL database files to C:\Nuance\Data.

4. Click Next to continue to reach the following dialog and enter the server settings.

DECISION
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Step 5 - RAS and Profile Storage File Server Settings

The following dialog is only an example. 

RAS URL

For non-cluster configurations, use the host name for the Application Server.

For cluster configurations, use the FileShare Service Host Name.

Profile Server IP Address

For non-cluster configurations, this is the IP address of the file server that acts as the
Roaming Profile storage and must be specified here. Do not use the host name.

For cluster configurations, use the IP address assigned to the FileShare Service Host
Name.

If this is a Remote Profile Storage Server, the option will not be shown.
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Profile Folder Local Path

This is the location where the user profiles are stored, for example:

 Location on the application server where user profiles are stored
\\<servername>\DragonUsers.

If this is a Remote Profile Storage Server, the option will not be shown.

5. Enter Service account name and password as \<Service Account>.

Step 6 - Service Account for SUS

After clicking Next in the section above, the following dialog displays.

6. Enter the Windows Service Account Name and password account you used on the
Application, SQL, and Mobile server.

7. After entering the information, click Next to display another dialog for the Speech
Node that is nearly the same as the one above.

8. Enter the same Windows Service Account Name and password account you used
on the Application, SQL, and Mobile server.

9. Click Next.
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10. Click Install.

SUS uses a tool to execute commands remotely on the file server hosting the User
profiles.

The installer launches the PSEXEC tool at the end of the installation to force the
user to accept the EULA if you have never accepted it on the same box. 
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After the installation is complete, the following dialog displays.

11. Click Finish and close all windows.

Enable UAC

In order for Remote Diagnostics to properly operate, it requires that the User Account
Control (UAC) settings be enabled on the servers. This should be set to the second
(2nd) lowest setting.

1. From Start select Control Panel.

2. On the Control Panel, click User Accounts.

3. On the User Accounts window, click User Accounts.

4. On the User Accounts tasks window, click Turn User Account Control on or
off.
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5. Adjust UAC to the level shown below:

6. Click OK.

7. Click Restart Now to apply the change right away, or click Restart Later, and
then close the User Accounts tasks window.

8. Verify Remote Diagnostics Configuration.

9. Reboot the server.
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PowerXpress

When upgrading the PowerScribe 360 system, you must also upgrade the PX2008 to
the latest.

Version Check

The following example shows how to check the current version on the PowerXpress
Server.

If the version is not at the latest v6.0, use the following steps to upgrade from V5x
or V6, to the latest V6:

 Upgrade V5.x to V5.0.56416

 Upgrade V5.0.5641 to V6.x

 Upgrade V6 - V6.0.6219

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html#PowerXpress
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Upgrade V5.x to V5.0.56416

When upgrading to PowerScribe 360 Version 2.X, the PowerXpress Server must be
running the latest version. You are required to uninstall PowerXpress 2008 and install
the latest supported version.

Preparation

1. Create the following folders:

 C:\Px2008_<Old Version>\Install

 C:\PX_DB_BACKUP

2. Stop Px2008 Service.

3. Create a backup of existing Px2008 folder and store in safe place.

4. Right-click on Px2008 outbound connection, and select Extended properties. The
Power Scribe Advanced Properties dialog displays.
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.

a. To view extended properties, right-click outbound to RIS connection and
select “PowerScribe Extended Properties”:
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You will see points of concerned circled.

5. On the PowerScribe Advanced Properties dialog, scroll to check the following
Allowed Code Entries:

 Pathology Model: If not set to 0, (zero), set to 0.

 Report Body, Format report body - If this is set to TX format - Single OBX
(Several report lines in one OBX per transmission), then check the output
after the install to make sure that this is still TX (OBX|1|TX|...). If it is not,
please contact support.

6. Create an Install folder.

7. Create the following folders in the Install folder:

 A folder with an appropriate name for the current version of Px

 A folder with an appropriate name for the update version of Px
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8. From the PxSetup Files menu, select Backup Database.
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9. From the PxSetup Files menu, select Save Settings to XML.
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10. Copy the new files from the following sub folders in the Install folder:

 PSFiles

 XmlConfigFiles
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11. Take a snapshot of the RadBridge setting and save the image file to the Install
folder.

12. Copy the Px2008.MSI file if present to the Install folder.

13. Copy the new Px2Ps_Installer.msi to C:\Px2008_<New Version>\Install.
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In the end, You should now see the following in this folder:

 PNG image of Bridge settings

 XML config files

 PSFiles

 Latest Px2Ps_Installer.msi version posted on the Definitive Media Library
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14. From the Settings menu, select Uninstall Px2008 Service.
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15. From the Control Panel, Programs and Features list, select PowerXpress2008 and
click Uninstall.
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16. Once Px2008 is removed, clean the Registry and delete Dictaphone Corp Key.
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Install Px2008

1. Double-click Px2Ps_Installer.msi.
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The Welcome to the PowerXpress2008 Setup Wizard displays.
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2. Click Next. The Select Installation Folder dialog displays.

Ensure to install the software in the correct location where the Px2008 folder
resides.
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3. Click Next until the Install Complete dialog displays.

4. Click Close.

Wait for the three PX2008 icons (monitor, setup, and app) to display.

5. Double-click the PX2008 setup icon. The PowerXpress2008 login dialog
displays.

6. Enter ... in Log Name, and click OK.
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The Create Database dialog displays.

7. Select the SQL DB namespace, and click OK. The PxSetup dialog displays.
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8. From the Settings menu, select Run SQL Scripts.

The Script Files for SQL Server dialog displays.
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9. Scroll the list, and check a red script, and then click Add Columns.

The Added dialog displays.

10. Click OK.

11. Repeat Step 10 and Step 11 for all the red scripts in the list. * There could be only
1 or there may be several scripts*

12. Click Close.
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13. From the File menu, select Schedule backup.

The Backup dialog displays.
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14. Set up the following scheduled backup as shown below:

 Backup Path: PX_DB_BACKUP

 Backup Interval: Weekly

 Time to Backup: 3am

15. Click OK. The Backup Database completed dialog displays.
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16. Click OK.

17. If install option is grayed out and only uninstall is available, reboot-the server.
Install option should now be available.

The InstallUtil.exe runs and the Install Successfully dialog displays.
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The Installed Successfully dialog displays.

18. Click OK.

19. From the PxSetup Start/Stop menu, select Start PS2008 Service.
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The Px2008 Monitor dialog displays.

20. From the Start/Stop menu, select Start PX2008 Service.
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Upgrade V5.0.5641 to V6.x

The Px2008 V6 is a standalone HL7 interface that no longer requires an SQL database
to run. Use the following procedures to backup Px2008 V5.x and install the latest
version of Px2008 V6 software.

Preparation

PSFiles Folder

1. Clean up the PSFiles folder by moving any PX200DB_YYMMDDHHMMSS.zip
files from the DB backups, if any exist.

XMLConfig Files Folder

1. Clean up the XMLConfig files folder that exists in 
C:\PowerXpress2008\XmlConfigFiles.

Backup PX2008 V5 Files

1. Double-click the Px2008Setup icon,  on the desktop.

The PowerXpress2008 Login dialog displays.

2. Enter ... in the Login Name without entering the Password.

https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html
https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html
https://isupportcontent.nuance.com/healthcare/PowerScribe360ReportingSoftwareMatrix/LatestSoftwareVersions.html
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The PxSetup dialog displays.

3. From the File menu, select Save Settings To XML.
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The Browse For Folder dialog displays. 

The default save location is to the C:\PowerXpress2008\XmlConfigFiles 
folder.

4. Click OK.

The current configuration is saved to C:\PowerXpress2008\XmlConfigFiles
folder.
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5. From the File menu, select Backup Database.

A current PX2008 database is created and the Backup Database completed dialog
displays.

6. Click OK.

7. For upgrades on the current server:

a. Keep a copy of the C:\PowerXpress2008 folder.

b. In the C:\PowerXpress2008 folder, delete all files except for the files in
C:\PowerxPress2008\Psfiles and C:\PowerxPress2008\XmlConfigFiles.

8. For new servers or VM servers, move a copy of the C:\PowerxPress2008\Psfiles
and C:\PowerxPress2008\XmlConfigFiles folders to the new or VM servers.

Uninstall PX2008 V5 from Control Panel

1. From the Px2008 Start/Stop menu, select Stop Px2008 Service.

2. From the Px2008 Settings menu, select Uninstall Px2008 Service.

3. From the Control Panel, select Programs and Features.

4. Right-click PowerXpress2008, and select Uninstall.
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The Program and Features dialog displays.

5. Click Yes.

Install PX2008 V6.x

1. Create folders for:

a. Existing Server Installs - The server should have a cleaned
PowerXpress2008 folder on the root drive that only contains the PSFiles and
XMLConfigFiles folders saved from V5.x.

b. New Server Installs - Create a PowerXpress2008 folder and copy of the
PSFiles and XMLConfigFiles folders saved from V5.x.

2. Create a folder:

 C:\PowerXpress2008\Install

3. Download and unzip the PX2008 zipped (Px2008_v6.0.5846.zip) software from
the Definitive Media Library to the C:\PowerXpress2008\Install folder.

4. Right-click on setup_Px2008_6.0.6092, and run as administrator.

The Welcome to the PowerXpress2008 Setup Wizard displays.

5. Click Next.
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License Agreement dialog displays.

6. Select I accept the terms in the license agreement and click Next.
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The Select Installation Folder dialog displays.

The default install Folder is C:\PowerXpress2008\.

7. Confirm the destination folder, and click Next.
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The Ready to Install the Program dialog displays.

8. Click Install.

The software installs and the Installation Wizard Completed dialog displays.

9. Click Finish.
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10. If .NET Framework Version 4.5 is not installed, the following .NET Framework
Initialization Error displays.

11. Double-click the Px2008Setup icon,  on the desktop.

The Px2008 dialog displays.

12. Click No.

13. The PowerXpress2008 Login dialog displays.

14. Enter ... in the Login Name without entering the Password.

If a Path not found dialog displays, click Yes.

The PxSetup dialog displays.
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15. From the File menu, select Import Settings from XML.

The Select XML files Directory dialog displays.

The default should be PowerXpress2008\XmlConFigFiles.

16. Click OK.
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The XmlConfigFiles dialog displays.

17. Click Check All, and then click OK.

You will see the XMLConfigFiles Load and the IP and Ports will display.

Schedule PX2008 Backup

1. From the PxSetup, select from the File menu, Schedule Backup.

The Backup dialog displays.

2. Select or create the Backup Path to C:\PowerXpress2008 Backup.

3. Set the Backup Interval to Weekly.
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4. Set the Time to Back to 3am.

5. Click OK.

6. From the File menu, select Backup Database.

The Backup Database completed dialog displays.

7. Click OK.

8. From the Settings menu, select Install Px2008 Service.

The DOS screen displays and the Installed Successfully dialog displays.

9. Click OK.

Set File and Exe Properties

1. From Windows Explorer, navigate to the C:\PowerXpress2008 folder. 
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2. Right-click the PowerXpress2008 folder and select Properties.

The Properties dialog displays.
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3. Select the Security tab, and then select Users.

4. Select Edit to change User Permissions to Full Control.

5. Check all the Allow Permissions options for Users for Full Control, and click OK.

6. On the Security dialog, click OK to save the Properties settings.
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7. Set the PX2008.exe, Px2008_Monitor.exe, and PxSetup.exe programs to run as
administrator as follows:

a. From Windows Explorer, navigate to program *.exe file. The default program
location is C:\PX2008.

b. Right-click the program *.exe file, and select Properties.

c. Select the Compatibility tab, and click Change settings for all users.
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The Compatibility for all users dialog displays.

Click Run this program as administrator and click OK.

d. Click OK to save the Properties.

e. Repeat the above steps for each *.exe program file.
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Upgrade V6 - V6.0.6219

1. Create the following folder:

C:\Px2008_<Old Version>\Install

2. Stop Px2008 Service.

3. Create a backup of the existing Px2008 folder and store it in safe place.

4. Create an Install folder.

5. Create the following folders in the Install folder:

 A folder named for the current version of Px

 A folder named for the update version of Px

6. From the PxSetup Files menu, select Save Settings to XML.
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7. Copy the new files from the following sub folders in the Install folder:

 PSFiles

 XmlConfigFiles

8. Take a snapshot of the RadBridge setting, and save the image file to the Install
folder.

9. Copy the Px2008.MSI file if present to the Install folder.
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10. Copy the new Px2Ps_Installer.msi to C:\Px2008_<New Version>\Install.

You should now see the following in this folder:

 PNG image of Bridge settings

 XML config files

 PSFiles

 Latest Px2Ps_Installer.msi version posted on the Definitive Media Library

11. From the settings menu, select Uninstall Px2008 Service.

12. From the Control Panel, Programs and Features list, select PowerXpress2008,
then and click Uninstall.
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13. Once Px2008 is removed, clean the Registry and delete Dictaphone Corp Key.
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Install Px2008 6.0.6219

1. Double-click Px2Ps_Installer.msi.

The Welcome to the PowerXpress2008 Setup Wizard displays.

2. Click Next. The Select Installation Folder dialog displays.

Ensure to install the software is in the correct location where the Px2008 folder
resides.
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3. Click Next until the Install Complete dialog displays.

4. Click Close.

5. Double-click the PX2008 setup icons. The PowerXpress2008 login dialog
displays.

6. Enter ... in Login Name, and click OK.
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7. From Settings select Install Px2008 Service.

8. Click OK.

9. From the PxSetup Start/Stop menu, select Start PS2008 Service.
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Enable UAC

In order for Remote Diagnostics to properly operate, it requires that the User Account
Control (UAC) settings be enabled on the servers. This should be set to the second
(2nd) lowest setting.

1. From Start select Control Panel.

2. On the Control Panel, click User Accounts.

3. On the User Accounts window, click User Accounts.

4. On the User Accounts tasks window, click Turn User Account Control on or
off.

5. Adjust UAC to the level shown below:

6. Click OK.

7. Click Restart Now to apply the change right away, or click Restart Later, and
then close the User Accounts tasks window.

8. Verify Remote Diagnostics Configuration.

Set Services to use the Services Account

Verify the following services are running under the same Windows Services account.

 DistributedManagementFramework: Agency

 PX2008
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Delete Px2008DB

1. Open Microsoft SQL Server Manager Studio.

2. Expand Databases.

3. Right-click on Px2008DB, and select Delete.

Uninstall MSSQL Express

1. Open Control Panel > Programs and Features.

2. Select MSSQL Express, and choose Uninstall. 
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Upgrade Add-On Products / Modules

Hot Spare

Re-enable the SQL AlwaysOn if the system has a hot spare. Refer to Hot Spare
Installation and Configuration — 889715.

Upgrade ModLink V2.2

Pre Upgrade

1. Download ModLink 2.2 installer.

a. Currently at www.pacsgear.com/download/ModLink2.2.0.zip

2. If not already there create a folder on the C:\ drive called ModLink support.

3. Create a folder within that called ModLink Installer 2.2.

4. Unzip ModLink2.2.0.zip into the installer folder in the support folder

5. Create another folder in the ModLink support folder called [ModLink x.x backup
YYYYMMDD].

6. Open a new window and find where ModLink is currently installed.

a. 1.1-2.0: default location is C:\Program Files (x86)\Perceptive 
Software\ModLink.

b. 2.1 and later: default location is C:\Program Files (x86)\Lexmark\ModLink.

7. Copy the CONFIG, DATA, and LOG folders to the backup folder you created.

8. Stop the ModLink service and close ModLink.

Upgrade

1. Run the ModLink install.

a. Right click on ModLink Setup.exe.

b. Go through the prompts.

c. ct should install .Net 4.5 if needed.

d. It will upgrade ModLink to the 2.2.

e. Upgrading from 2.0 or 2.1 is supported. For any version older than 2.0 please
contact Lexmark.

www.pacsgear.com/download/ModLink2.2.0.zip
https://isupportcontent.nuance.com/healthcare/documents/manuals/889715/889715.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889715/889715.pdf
https://isupportcontent.nuance.com/healthcare/documents/manuals/889715/889715.pdf
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Post Upgrade

1. Open ModLink and confirm the service is running and that ModLink has been
upgraded.

a. Help ->About

2. If Modlink Web Forms was installed prior to the upgrade.

a. Go to C:\Program Files (x86)\Lexmark\ModLink Web 
Forms\PGAPPS\web.config.

b. Right click and select edit.

c. Confirm that the ModLink section it pointing to the correct location. If they
are upgrading from an older version it might be pointing to an older folder
location.

<!-- ML items need to point to local ModLink install-->
<add key="ConfigFolderPath" value="C:\Program Files 
(x86)\Lexmark\ModLink\config"/>
<add key="ModlinkDataPath" value="C:\Program Files 
(x86)\Lexmark\ModLink\DATA\MODLINK_DATA"/>
<add key="FWDAPIJobPath" value="C:\Program Files 
(x86)\Lexmark\ModLink\DATA\JOBS\FORWARD"/>
<add key="HL7APIJobPath" value="C:\Program Files 
(x86)\Lexmark\ModLink\DATA\JOBS\HL7"/>
<add key="DICOMXMLOutputPath" value="C:\Program Files 
(x86)\Lexmark\ModLink\DATA\SR\XML_OUT"/>
<add key="HL7XMLOutputPath" value="C:\Program Files 
(x86)\Lexmark\ModLink\DATA\HL7\HL7_XML"/>
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Upgrade ModLink Web Forms V1 to V2

Pre Upgrade

Several days prior to performing the upgrade from V1.0 Web Forms to V2.0, you must :

1. Copy the ModlinkWebForms database file from the Lexmark > ModLink Web
Forms > PGAPPS > App Data folder

2. Email the file to Lexmark (Gregory Masek gregory.masek@lexmark.com)
Lexmark runs the V1.0 ModlinkWebForms database through a converter for V2.x.

3. Save the converted V2.0 ModLinkWebForms file for the Post Upgrade Process
Step 2.

Backup the Config Files

1. To save the settings for V1.0 Web Forms, create a new folder on the desktop
called Config Backup with the date of the backup in the folder name, for example
(Config Backup 20170202):

2. From C:/Program files (x86) /Lexmark/ModlinkWebForms/ directory, copy the
configuration settings config folder into the backup folder you just created.
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Upgrade Process

1. From the Control Panel > Programs, click Uninstall a program.

2. The Uninstall or change program dialog displays.

3. In the program list, select ModLink Web Forms, and click Uninstall.
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The confirmation message appears.

4. Click Yes.

The Preparing to remove dialog displays.

The ModLink Web Forms dialog displays. 

5. Click OK.

The following dialog displays.

After the uninstall, the Lexmark/ModLink Web Forms folder remains.

6. Delete the ModLink Web Forms folder, and then select Restart to reboot.
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7. Download and unzip the ModLink software from the Definitive Media Library.

8. Right-click ModLink Setup.exe, and select Run as administrator.

The PACSGEAR Core Server InstallShield Wizard dialog displays.
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After the files are extracted, the Windows Installer dialog displays.

The Welcome dialog displays. Please wait message displays. This may take a few
minutes.

Then the PACSGEAR Core Server dialog displays.

9. Click Next. 
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The License Agreement dialog displays.

10. Select I accept the terms in the license agreement, and click Next.

The Custom Setup dialog displays.

11. Click Next.

The Ready to Install the Program dialog displays.

12. Click Install.
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The Installing PACSGEAR Core Server dialog displays. This may take several
minutes. 

13. Click Next.

The InstallShield Wizard Completed dialog displays. 

14. Click Finish.

The PACSGEAR Core Server software is installed in the C:\Program Files
(x86)\Lexmark directory.
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15. In the C:\Program Files (x86)\Lexmark\PACSGEAR Core Server\PGAPPS
folder, select Web.config and edit the file with Notepad++ or Notepad.

The xml config code displays.



PN 889679 March 31, 2017 1-119

16. Verify the ModLink value paths are pointing to the local ModLink install, and if
necessary, change the value paths to the local ModLink install location where the
software is installed:

Post Upgrade Process

If upgrading from Web Forms 1.0 to Web Forms 2.0 a new license key
from Lexmark will not be needed if upgrading on the same VM/Server. 

1. Open current License XML file located in ModLink 2.x config folder
or the 1.0 Web Forms “config” folder. Location will depend on where
products were installed. Default locations are:

- C:\Program Files (x86)\Lexmark\ModLink
- C:\Program Files (x86)\Lexmark\ModLinkWebForms\

2. Open the “license.xml file and record the <KEY> alphanumeric
code.

***Note, this will only work if installing on same VM if a new VM or
server is used a new license file will need to be generated.

3. When starting WebForms for the first time, after the upgrade, enter
the license key from the above xml file into the License key file and select
OK.

1. Copy and paste/replace the following files from the Config Backup folder you
created, to the newly installed config folder:

 defaults.config

 departments.config

 dicom.config

 license

 users
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2. Replace the V1.0 ModlinkWebForms database file with the converted V2.0
ModLinkWebForms database file in the Lexmark > ModLink Web Forms >
PGAPPS > App Data folder > ModlinkWebForms folder.

3. Launch a web browser, and go to https://127.0.0.1/pgapps

https://127.0.0.1/pgapps
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The Lexmark License dialog displays. 

NOTE: During the V1 install, the client received a License key. The
license key is required to log in for WebLink Web Forms.
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4. From the Product list, select ModLink Web Forms.

The License dialog updates. 
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5. Enter the License Key, and click Save.

The License checks and the Login dialog displays.

6. Enter the User name and Password, and click Log In.

The Dashboard displays.
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Upgrade mPower

Backup DB

Move this copy to another server for security. Refer to iSupport Solution 19963:
mPower Backup and Restore Procedures.

Upgrading

You must first upgrade the system to Montage 3.0 before proceeding
with a newer version. Refer to PN 889681 — PowerScribe® 360
Reporting Montage Installation Manual for upgrading to 3.0 if
necessary.

1. Run the Windows Update to get the latest patches. 

2. Disable UAC and reboot. 

3. Reboot the server.

4. Check the Indexer task to make sure it ran the night before. If so move to the next
step, but if not, enable it, run it and wait for it to complete. This could take hours
to do so you may want to check this to see if it is running before the upgrade date.

5. Backup the settings.py and montage-modules.json files.

6. If the Montage server has SSL enabled and Cert installed in Windows, any prior
installation of HTTPS certificates in Apache, need to be manually migrated after
the upgrade. 

Follow the HTTPS Certificate Migration guide (currently page 47 in 3.2 manual) 
to move them from C:\ProgramFiles(x86)\Apache Software 
Foundation\Apache2.2 to C:\montage\config\ssl and edit 
C:\montage\config\apache.conf for the appropriate SSLCertificateFile and 
SSLCertificateKeyFile. Requires a restart of the Montage Apache Service.

7. Check to see if the logs have been relocated. If so, the new log file and location
should be setup in the settings.py before the upgrade runs. 

Example below: 
LOGGING['handlers']['indexer_file']['filename'] = 
'D:\\montage\\data\\logs\\montage-indexer.log'

8. Backup the DB and rename it for safe keeping.

9. Disable any tasks that are scheduled (DB backup and Montage Indexer).

10. Stop all services, and set them to Manual except for PostgreSQL. 

11. Backup the Montage\Config folder, all of the log files in Montage\data\logs and
the media folder in c:\montage\data\media. Note: the log files could be on a
separate drive that C.

https://isupportcontent.nuance.com/healthcare/documents/manuals/889681/889681.pdf
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12. Run the Montage installer. It will detect and upgrade all required components.

The Welcome dialog displays.

13. Click Next.



PN 889679 March 31, 2017 1-126

The Montage License Agreement dialog displays.

14. Click I Agree.

The Montage installation will install all components listed. Checks to determine
the system state are encompassed within the install components.

15. Click Install.

The installer will take a few minutes.

Reboot Server

Reboot the Server.

Check Services

Once mPower is upgraded, you need to confirm that the Services are started.

Verify that the “Montage Apache”, “Montage Searchd”, “Montage Celeryd”, and
“Montage Celerybeat” services are running. If they are stopped, start them. 
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WARNING: Only start “Montage MLLP Server” if it Montage is receiving HL7
messages.

16. On a Win 2008/R2 server, an error message may appear, The installer has detected
in the settings.py file possible incompatibilities for Montage >=3.2. 

a. Check the file C:\montage\incompatible.txt to make sure there are no issues
that need to be addressed.

17. When the installer is finished, restart the Montage Celerybeat, Montage Celeryd,
Montage Apache, Montage Searchd, and Montage MLLP Listener (if using HL7). 

a. This should start a full index. You can check this by looking in the file called
montage-indexer.log. A Full re-index will run when the CeleryD service
starts and could take several hours. 

b. If it does not automatically start after the upgrade completes, run the new
Indexer as follows. 

A full index command is:

C:\montage\lib\montage-3.2.x\bin\montage run_indexer --full --all

18. Log in to the Montage web page. 

19. Check all logs, especially the incompatible.txt and 
c:\montage\lib\montage-3.2.x\install.log for errors.

20. Check to see if the scheduled indexer task is gone. It should have been removed
via the upgrade.

21. Re-enable the Montage Database Backup task.

22. Set all services back to Automatic if they are not set after the upgrade.
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Enable UAC

In order for Remote Diagnostics to properly operate, it requires that the User Account
Control (UAC) settings be enabled on the servers. This should be set to the second
(2nd) lowest setting.

1. From Start select Control Panel.

2. On the Control Panel, click User Accounts.

3. On the User Accounts window, click User Accounts.

4. On the User Accounts tasks window, click Turn User Account Control on or
off.

5. Adjust UAC to the level shown below:

6. Click OK.

7. Click Restart Now to apply the change right away, or click Restart Later, and
then close the User Accounts tasks window.

8. Verify Remote Diagnostics Configuration.

Set Services to use the Services Account 

Verify the following services are running under the services account.

 DistributedManagementFramework: Agency
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Update CRM

1. Update the connection information with correct information, creating / correcting
a connection for each server.

2. Update the Version Information, indicating the correct version of each component.

3. Update / correct user IDs and Passwords, correcting and removing (blanking out)
incorrect IDs / passwords no longer valid.
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4. Update/correct user IDs and Passwords, correcting and removing (blanking out)
incorrect IDs/passwords no longer valid.

5. Go to the Equipment Information.

6. Click Edit.

7. Update the relevant information related to activation codes and URLSA for
add-ons.
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Appendix 1 - Troubleshooting

Password Conversion Issues

If, after performing the upgrade, and you cannot log into the Portal with the correct
ADMIN password, you may need to rerun the password conversion. This can fail
during the upgrade process if the connection to RAS is interrupted.

To convert the passwords if the upgrade password fails during the upgrade process,
perform the following:

1. From the C:\inetpub\wwwroot\RadPortal folder, right-click PortalConfigUI.exe
and select Run as Administrator. 

The Portal Configuration dialog displays.

2. On the Portal Configuration dialog, click OK.

If there are any account passwords that need to be converted, the Utility
will convert them and will present a dialog with the following:

"Security upgrade succeeded. {0} account passwords have been converted to
one-way salted hashes."  << {0} Number of accounts converted.
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Login Issues

V4.0 DBSetup Update - BypassLDAP Flag

ISSUE: Unable to login to default administrator account after running v4.0 DBSetup
update.

In version 4.0, during the DBSetup process, a new flag, BypassLDAP, is added to the
accounts table. If LDAP is enabled on the system prior to running the DBSetup, the
BypassLDAP flag is set to 0 (false). This can potentially lock access to the default
administrator (admin) account. 

If this occurs, run the following script to set the BypassLDAP flag to 1 (true) to login
to the default administrator account.

update account

set bypassldap = 1
where loginname = 'admin'

Note this can also occur if LDAP is turned on, but the configuration is incorrect or the
LDAP server is inaccessible, all accounts that do not have the BypassLDAP flag set to
true would be inaccessible.
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Manual Revision History
Note: In this table the most recent changes are first by date.

Date Sec Page Change (Paragraph, Sentence, Figure, Table, etc.) Initials

3/31/17 1 124 Add to upgrade steps beginning of page 1-124, before step 1:
1. Run Windows Update to get updated to latest patches.
2. Disable UAC and reboot 
3. Reboot the server
4. Check the Indexer task to make sure it ran the night before. 

If so move to the next step, but if not, enable it, run it and 
wait for it to complete. This could take hours to do so you 
may want to check this to see if it is running before the 
upgrade date

5. Backup the settings.py and montage-modules.json files.
6. Does the Montage server have SSL enabled and Cert 

installed? If so, in Windows, any prior installation of HTTPS 
certificates in Apache, need to be manually migrated after 
the upgrade. Follow the HTTPS Certificate Migration guide 
(currently page 47 in 3.2 manual) to move them from 
C:\ProgramFiles(x86)\Apache Software 
Foundation\Apache2.2 to C:\montage\config\ssl and edit 
C:\montage\config\apache.conf for the appropriate 
SSLCertificateFile and SSLCertificateKeyFile. Requires a 
restart of the Montage Apache Service

7. Check to see if the logs have been relocated, if so, the new 
log file and location should be setup in the settings.py 
before the upgrade runs. Example below. 
LOGGING['handlers']['indexer_file']['filename'] = 
'D:\\montage\\data\\logs\\montage-indexer.log'

8. Backup the DB and rename it for safe keeping.
9. Disable any tasks that are scheduled (DB backup and 

Montage Indexer).
10. Stop all services, and set them to Manual except for 

PostgreSQL. 
11. Backup the Montage\Config folder, all of the log files in 

Montage\data\logs and the media folder in 
c:\montage\data\media. Note: the log files could be on a 
separate drive that C.

BW
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3/31/17 1 126 Add the following to the end of the steps original steps:

12. If on Win 2008/R2 server, an error message may appear 
“The installer has detected in the settings.py file possible 
incompatibilities for Montage >=3.2,”. 

a.Check the file C:\montage\incompatible.txt  to make sure 
there are no issues that need to be addressed. 
13. When the installer is finished, restart the Montage 

Celerybeat, Montage Celeryd, Montage Apache, Montage 
Searchd, and Montage MLLP Listener (if using HL7). 

a.This should start a full index. Check this by looking in the file 
called montage-indexer.log. A Full re-index will run when the 
CeleryD service starts and could take several hours. 
b.If it does not automatically start after the upgrade completes, 
run the new Indexer as follows. 
i.Note: a full index command is 
C:\montage\lib\montage-3.2.x\bin\montage run_indexer --full 
--all
14. You should now log into the Montage web page. 
15. Check all logs especially the incompatible.txt and 

c:\montage\lib\montage-3.2.x\install.log for errors.
16. Check to see if the scheduled indexer task is gone. It should 

have been removed via the upgrade.
17. Re-enable the Montage Database Backup task.
18. Set all services back to Automatic if they are not set after 

the upgrade

BW

3/17/17 1 41 Added PowerShare Accelerator section. BW

Date Sec Page Change (Paragraph, Sentence, Figure, Table, etc.) Initials
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2/15/17 1
1
1
1
1

1
1

1

1

1
1
1

1

1

1
1
1
1

App
App
App

1
1
1

46
47-57

67
67-73

70

71

74
74
112

116

125

133
133
134
134
1
2
2

Change SQL content for Upgrade vs install.
Add Row before Install for Disable LDAP if it is ENABLED
Add Row at the end of Post Install: Re-enable LDAP, if disabled.
Insert new content for SQL Express email.
Delete entire SQL 2012 section.
SUS Graphics unnecessary to update, no changes
Change title from: Upgrade V6 - V6 to Upgrade V6 - V6.0.6219
Delete/move the section Upgrade V6 - V6 pgs 1-67 through 1-73to pg 
1-112 just before Enable UAC.
Delete Note: If the PX2008 version is lower than Px2008_v5.0.5641, you 
must first upgraded to PX 2008_v5.0.5641 before continuing Upgrade 
V5. to V6.
Change title Install Px2008 from 6.0.6037.37685 to Install Px2008 from 
6.0.6219
Change title Upgrade V5x to V6x to   Upgrade V5x to 5.0.5641
Delete subtitle Upgrade V5.x to V5.0.5641
Insert Upgrade V6 - V6.0.6219 pgs 1-67 through 1-73 to pg just above 
Enable UAC.
Delete/move the Post Upgrade NOTE ONLY with steps 1-3 to just below 
Post Upgrade Process title.
Insert the Post Upgrade NOTE and steps 1-3 from 1-116 to just below 
Post Upgrade Process title.
Replaced image - step 1.
Replaced image - step 2.
Replaced image - step 4.
Replaced image - step 7.
New section placeholder
Delete entire section to Upgrade AutoTexts.
Added Login Issues section to cover LDAP.

SP/BW
MS
MS
BW
BW
MS
BW
BW

BW

BW

BW
BW
BW

BW

BW
BW
BW
BW
BW
BW
MS
BW
MS

2/13/17 1
1
1
1

33
35
61
62

Modified Step
Typos
Add RAS
Step 5 Enter Service account name and password as \<Service 
Account>

MS
MB
MB
MB

2/9/17 1 115 Add note at the top of the WebForms section. (was pg 1-127) BW

2/9/17 1

1

1

1
1
1
1
1
1

42

42

42

42
42
43
43
44
44

Step 11: Changed reference to be sure to check the Enable
SpeechAnywhere box to Enable caching, if not checked.
Replaced Portal Configuration dialog that includes the Web Service Log 
Folder.
Added Note: The Web Service Log Folder field option is available on the 
Mobile Bridge Configuration dialog during upgrades to V4 and higher.
Added Optional Step 12.
Add New Step 13 for Mobile Bridge.
Added Optional Step 14 for Mobile Bridge.
Added new image for Mobile Bridge
Added Step 15 and new image for Pre-Installation Summary.
Updated Step 16 (no boot option on dialog) and image for Complete 
dialog.

BW

Date Sec Page Change (Paragraph, Sentence, Figure, Table, etc.) Initials
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2/8/17 1
1
1
1
1
1
1
1
1
1
1

1
1
1

10
29
29
29
29
42
43
44
48
49
51

51
53
74

Version for 4.0n Upgrade tool is not in DML - Brian?
Replaced graphic
Deleted step a: Right-click the Database Properties and select Options.
Deleted step b: From the Recovery model list, select Full.
Deleted step 18. Click OK.
New graphic - Matt
New graphic - Matt, Mobile Bridge
Change Note to icon.
Delete graphic 1
Delete graphic
Change This issue only impacts v3.x and is not required for any other 
version. to
This issue impacts v3.x and v4.x and is not required for other versions.
Delete Set Services to Use the Service Account section content.
Delete Set Services to Use the Service Account section content.
Delete Set Services to Use the Service Account section content.

Team

2/6/17 1 143 Removed RD section. BW

2/6/17 1
1
1
1
1

20
20
21
22
35

Replaced graphic 1
Replaced graphic 2
Replaced graphic
Replaced graphic 2
Replaced graphic

MS

2/3/17 1

1

127-
136
139

Added new process steps for ModLink Web Forms V1 to V2

Updated title for Solution 19663 to mPower

SP

2/3/17 cover
1-8
1-10
1-50
1-54

1-127

Remove | from the product name. SP

1/26/17 1 7
9

10
10
11
12
13
13
15
16
16
17
17
17
18
20
20
21
24
29

Add url http://sha256timestamp.ws.symantec.com/sha256/timestamp
Delete both graphics and delete note about graphics.
Delete: This version MUST be used for any upgrade to 3.5 and above. 
Update linked document.
Delete graphic.
Whiteout versions.
Delete graphic
Delete graphic
Delete graphic 
Delete graphic 1
Delete graphic 2
Delete graphic 1
Delete graphic 2
Add note The check reporting message will display.
Delete graphic
Update graphic 1 - Matt 
Update graphic 2 - Matt 
Delete graphic 2
Update graphic 1 - Matt 
Updated steps for PS3600 Update All Statistics.txt file for Confluence.

Team

1/18/17 1 125 Added Hot Spare instructions for SQL AlwaysOn. MB/BW
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1/10/17 1
1
1
1
1
1

126
127
129
130
131
132

- Start mPower Upgrade on new page.
- Reboot Server, lower heading, eliminate white space.
- Check Services, lower heading, eliminate white space
- Enable UAC, lower heading, eliminate white space
- Eliminate white space
- Set Services to use the Services Account, lower heading

BW

1/9/17 1

1

1

127

128

130

- Change mPower Upgrade title to H2 under Upgrade 
- Delete Run the task to create a current copy of the database.
- Add Refer to KB article.
- Delete Montage in Upgrading Montage title
- Change Stop: 
- Delete Note: Download the Montage 3.1
- Delete step 1
- Delete step 2
- Delete step 3
- Delete step 4.
- Delete step 5.
- Delete paragraph, As of Montage....
- Delete Montage Installer title.
- Change step 1:- To upgrade from v3.0 or 3.0.1, you should run the 
Montage installer. It will detect and upgrade all required components.
to:
Run the Montage installer. It will detect and upgrade all required 
components.
- Delete step 2.
- Change step 3 to step 2.
- Change:  Once Montage is upgraded, you need to confirm that the 
Montage servers are started. Check that the “Montage Searchd”, 
“Montage Celeryd”, and “Montage Celerybeat” services are running. If 
they are stopped, start them.
To:
Once mPower is upgraded, you need to confirm that the Services are 
started. Verify that the “Montage Searchd”, “Montage Celeryd”, and 
“Montage Celerybeat” services are running. If they are stopped, start 
them.

- Delete note: Whenever there is a configuration change (e.g. to 
C:\montage\config\settings.py), the services (“Montage Apache”, 
“Montage Celeryd”, “Montage Celerybeat”, and optionally “Montage 
MLLP Server”) must be restarted to reload the configuration file.

BW

1/4/17 1 51 Change Fax note to title/paragraph. BW

1/4/17 1
1

1
50

Added Pre-Upgrade Checklist table.
Added Fax note.

BW

1/2/17 1 109

110

Change step 4 to Right click on setup_Px2008_6.0.6092 and run as 
administrator.
Add License Agreement after step 5.
Replace Destination dialog.
Add new dialog, Ready to Install the Program
Replace Installation Complete dialog.
Inserted .NET Framework Initialization Error dialog before the install 
.NET step.

MB/BW

12/19/16 1 133 Change table as provided in the 4.0 Dec. 12, 2016 version. SEP
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12/1/16 1 49
50
51
52
53
54

Removed steps 14, 15
Removed steps 16-18, 20
Removed steps 21-23
Removed steps 24-27
Removed steps 28-30
Removed step 31

SEP

11/15/16 1 1
37
43
58

typos SEP

11/14/2016 1
1
1
1
1
1
1
1

12
13
15
16
17
39
40
41

Updated/replaced image.
Updated/replaced image.
Updated/replaced image.
Updated/replaced image.
Updated/replaced image.
Optional Screen text/replaced image.
Updated/step/image 10.
Added step/image 11.

SEP

10/13/2016 1 124 Added Steps to take a backup of Montage DB.
Added Section 2 of Montage 3.1 installation manual.
Add Page 3-4 of Montage 3.1 installation manual.

SEP

10/6/2016 All All Changes found after a test run of the upgrade process. SEP

9/29/2016 All All This version contains over 160 edits. It has been reorganized and many 
of the sections have been deleted.

SEP

8/19/2016 1 151 Replaced CRM step 7 image. SEP

8/12/2016 1 145 Added Notes. SEP

8/9/2016 1 92
141

Added Px2008 separate instructions.
Updated the entire Final Steps section.

SEP

7/20/16 1 68 Updated for Client Hot Fix for 2.0.3 SEP

7/18/16 1 68 Updated, 2.5.3, 2.5.2, and 2.5.1 Client Hot Fixes for July. SEP
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7/8/16 1 1
55

62
68
69
70
93
93
108

114

115
115

Added 3.0.1 Software Installation Manual
Added The feature is supported in PS 360 v3.5.1, v3.0.1, v2.5.3 and 
v2.0.3  ONLY.
To use this tool you must first install the  proper hot fix version of the 
Client Admin Utility. v3.0.1 
(PS360v301ClientAdminUpdate-4-7-2016.zip), v2.5.3 
(PS360v253ClientAdminUpdate-4-7-2016.zip) and v2.0.3 
(PS360v203ClientUpdate-50713-5-31-2016.zip)
Added DOD note.
Changed to 2.5.3. or higher
Added heading Update Worklists
Replaced all installs with a table identifying the patch/hot fixes to apply
Changed title Upgrade PX2008 to Pxv6.0.5951 or higher.
Deleted Note about monitoring server.
Deleted Disable SQL Express
Deleted steps 1-5
Added Uninstall MSSQL Express
Added two steps.
Removed important icons
Deleted several paragraphs.
Moved Verify to top of page.
Added new section, Upgrading an existing server
Modified step 3.
Added new content. after step 3.

SEP

7/5/16 1 8 Added Upgrade AlwaysOn SQL section. SEP

6/27/16 1 57 Added V3.5.1 Client Update (b6.5.28.2) and V3.5.1 Client Update UK 

(b6.5.28.2)

SEP

6/24/16 1 53 Added V2.5.3 Client Update (b5.5.72.16). SEP

6/21/16 1 56 Added V3.0.1 Radportal Update (b6.0.27.16). SEP

6/13/16 1
1
1

2
39
53

Added internet access for IPs and ports.
Added Troubleshooting section.
Added steps for V3.5.1 RadBridge Update 6.5.28.1 US 
(PS360v351RadBridgeUpdate-65281-6-13-2016-US) and/or V3.5.1 
RadBridge Update 6.5.28.1 UK 
(PS360v351RadBridgeUpdate-65281-6-13-2016-UK)

SEP

6/10/16 1
1

44
50

Added worklist information and file cabinet information.
Added step 13 for V2.5.3 RadPortal Update (5.5.72.15) 
PS360v253RadPortal-557215-6-9-2016.zip.

SEP

5/27/16 1 51 Added v3.0.1 RadBridge Update (6.0.27.16) SEP
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5/25/16  1

1

1
1
1

1
1
1

1
1

1
1

1

 4

5

43
44
54

62
66
71

73
74

1
1

1

PowerScribe® 360 | Reporting Windows Server 2008 R2 Installation 
and Configuration Manual.
Delete all existing Windows accounts previously used by the application, 
except for the accounts which were created as specified in P36A064 — 
Accounts and Passwords for PS360 Installation
Set Services to Use the Services Account
Set Services to use the Services Account
If the Versions are up-to-date for Dragon and SUS, verify the 
DistributedManagementFramework: Agency, SPARK and SUS Services 
are running under the services account created as specified in 
P36A064, then skip to PowerXpress Upgrade.
Delete note.
Set Services to use the Services Account
Enter the PS360 Windows Service Account created as specified in 
P36A064.
Set Services to use the Services Account
If the PX2008 version is lower than Px2008_v5.0.5641., you must first 
upgraded to PX 2008_v5.0.5641. before continuing to install v6.0.5951.
Set Services to use the Services Account
Set Services to use the Services Account
Verify the following services are running under the services account 
created as specified in P36A064.

SEP

5/17/16 1

1

2

4

Added Validate Nuance PDF Reader Version  (Upgrading to V 2.5.x 
ONLY)
Added Apply All Firmware and Microsoft Updates section.

SEP

5/09/16 1
1
1
1

2
5

49
99

Removed Disable Mirroring
Added Upgrading Systems with Mirrored Hot Spare Configuration
Added Password Conversion Issues and Upgrade AutoTexts
Updated Remote Diagnostic

SEP

4/28/16 1 48 Updated for 3.0.1 Patch 2 SEP

4/25/16 1 All Updated for V2.5.1, 2.5.2, and 2.5.3 patches. SEP

3/23/16 1 7 Add note about when to use the upgrade tool. SEP

02/19/16 1 2
83
85

Added Warning about Nuance PDF software.
Modified Montage Upgrade section.
Added more steps to the Final Steps.

SEP

01/22/16 1 38 Clarified the important note about 2.5.2 patch 1 or lower. SEP

01/12/16 1
1

1
1
1
1

1
42

64
79
80
84

Added note for Nuance PDF Application.
Added Mobile Server Certificates (All Systems Below v3.5) and Upgrade 
Mobile Server sections.
PowerXpress Upgrade section updated for new version.
Added Delete PX2008DB.
Added Delete SQL Express.
Added Final Steps

SEP

11/23/15 1 All Draft Version SEP
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